Abstract

This application note aims at getting started with the Atmel® SAM L10 and SAM L11 ARM®Cortex®-M23 based microcontrollers using their respective Xplained Pro evaluation kits.

The Atmel SAM L10 and SAM L11 Xplained Pro evaluation kits are hardware platforms used to evaluate the ATSAML10E16A and ATSAML11E16A microcontrollers.

Each kit is supported by the Atmel Studio Integrated development Platform, and provides an easy access to the features of the microcontroller.
Table of Contents

Abstract........................................................................................................................... 1

1. Device Documentation.............................................................................................. 3

2. Obtain the SAM L10/SAM L11 Xplained Pro Evaluation Kit...................................... 4

3. Obtain the Tools.........................................................................................................6

4. Getting Started With SAM L10/SAM L11 Using Atmel Studio 7 and START.............7
   4.1. Instructional Guide ...................................................................................................................... 7

5. Getting Started With SAM L11 Secure Solution Using Atmel Studio 7 and Start.... 13
   5.1. SAM L11 Security Concept Overview........................................................................................ 13
   5.2. Instructional Guide..................................................................................................................... 15

The Microchip Web Site................................................................................................ 38

Customer Change Notification Service................................................................. 38

Customer Support...................................................................................................... 38

Microchip Devices Code Protection Feature......................................................... 38

Legal Notice..................................................................................................................39

Trademarks................................................................................................................... 39

Quality Management System Certified by DNV....................................................... 40

Worldwide Sales and Service.................................................................................... 41
1. **Device Documentation**

**Data Sheet**

**Document:** SAM L10/L11 Family Data Sheet, which provides peripheral descriptions and electrical characteristics.

**Silicon Errata**

**Document:** SAM L10/L11 Family Silicon Errata and Data Sheet Clarification.
2. **Obtain the SAM L10/SAM L11 Xplained Pro Evaluation Kit**


To order the kit, access [Microchip Direct](http://www.microchip.com/).

**Documents:**
- SAM L10/L11 Xplained Pro User Guide (.pdf)
- SAML10-Xplained-Pro_Design-Documentation (.zip)
- SAML11-Xplained-Pro_Design-Documentation (.zip)

**Key Features:**
- ATSAML10E16A-AU or ATSAML11E16A-AU microcontrollers
- One mechanical reset button
- One mechanical programmable button
- One QTouch® button
- One user LED (yellow)
- 32.768 kHz crystal
• ATECC508A Crypto Authentication IC
• Two Xplained Pro extension headers
• One X32 header
• One mikroBUS header
• Embedded Debugger
  – Auto-ID for board identification in Atmel Studio
  – One status LED (yellow)
  – One board power LED (green)
  – Symbolic debug of complex data types including scope information
  – Programming and debugging, including power measurements
  – Data Gateway Interface: SPI, I²C, four GPIOs
  – Virtual COM-port (CDC)
• Embedded current measurement circuitry with Atmel Data Visualizer support for data visualization
• USB powered

**Tip:** The SAM L10/SAM L11 Xplained Pro User's Guide describes how to power the kit, and it also describes the detailed information on board components, extension interface and the hardware guide.
3. **Obtain the Tools**

Atmel Studio 7, which uses a GCC compiler, is the preferred IDE to get started with SAM L10/SAM L11 MCUs. Atmel START is the preferred user interface to generate the initial project. Any Atmel START project can be used in Atmel Studio 7, IAR or KEIL IDEs.

**Atmel Studio 7**
- **Web page:** Atmel Studio
- **Document:** Atmel Studio 7.0 web installer (.exe)

Atmel Studio 7 is the preferred IDE for developing and debugging firmware for SAM L10/SAM L11.

**Atmel Start**
- **Web page:** Atmel Start
- **Document:** Atmel Start User's guide: Also, use the help menu from the interface.

Atmel Start enables users to select and configure software components and tailor embedded applications in a usable and optimized manner.
4. Getting Started With SAM L10/SAM L11 Using Atmel Studio 7 and START

**Note:** The following steps are described using the SAM L10 Xplained Pro as reference; however, the same sequence can be performed using the SAM L11 Xplained Pro.

4.1 Instructional Guide

Follow these steps to start exploring the Atmel Xplained Pro platform:

1. Download [Atmel Studio](https://www.atmel.com/).
2. Install Atmel Studio.
3. Launch Atmel Studio.
4. Connect the kit to the PC using a micro-USB cable (Standard-A to Micro-AB).

When the Xplained Pro MCU kit is connected to the computer for the first time, the operating system will install the software driver. The driver file supports both 32-bit and 64-bit versions of Microsoft® Windows® XP, Windows Vista®, Windows 7, Windows 8 and Windows 10.

When the Xplained Pro MCU board is powered, the power LED (green) will glow and Atmel Studio will auto-detect the specific Xplained Pro MCU and extension boards that might be connected. Atmel Studio will provide links to relevant information, such as data sheets and kit documentation.

**Note:** The ATSAML10E16A and ATSAML11E16A devices are programmed and debugged by the on-board embedded debugger, hence no external programmer or debugger tool is required.

**Figure 4-1. Atmel Studio SAM L10/SAM L11 Xplained Pro Introduction**
5. Launch Atmel Start from Atmel Studio: File > New > Atmel Start Example Project, and then open Atmel Start directly into Atmel studio.

Figure 4-2. Opening Atmel Start Example Project in Atmel Studio

Atmel Start will load the existing example list.

6. Choose the example "LED Flasher" in the list, and then click Open Selected Example.

Figure 4-3. Atmel start SAM L1x Available Example List

7. Choose either the SAM L10 or SAM L11 Xplained Pro Board, and then click Select board.
Figure 4-4. Board Selection

<table>
<thead>
<tr>
<th>Board</th>
<th>Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAM L10 Xplained Pro</td>
<td>ATSAML10E16A</td>
</tr>
<tr>
<td>SAM L11 Xplained Pro</td>
<td>ATSAML11E16A</td>
</tr>
</tbody>
</table>

The example *LED flasher* is supported by more than one board. Select which one to use:
8. Click **GENERATE PROJECT** to generate the project from Atmel Start. My "Software Components Window" will be displayed.

**Figure 4-5. Atmel Start Project Generation**

9. The following window will be displayed: Enter Project Name, Solution, Solution Name, and then browse and choose a location for the project. Click **OK** to open the project in Atmel Studio.

**Figure 4-6. Atmel Studio New Atmel Start Project Importation**

The Atmel Studio will create the project.
10. Configure the Debugger/Programmer Interface by following these steps:
   - Open the project properties: Project > Properties or <ALT+F7>.
   - Click Tool.
   - For the Selected debugger/programmer, choose "EDBG ATMLxxx".
   - For the Interface, choose "SWD".

   Figure 4-7. Programming Tool Selection

11. Compile and run the LED Flasher application.
   - Build the project: Build > Build Solution or <F7>.
   - Load the code into the SAM L10 Xplained Pro and start debugging: Debug > Start debugging and break or <ALT+F5>.
   - The application is programmed and the debugger breaks in main.
   - Run the code: Debug > Continue or <F5>.
   - The example runs out of the Xplained Pro target.
5. Getting Started With SAM L11 Secure Solution Using Atmel Studio 7 and Start

5.1 SAM L11 Security Concept Overview

Using the ATSAM L11 requires to be familiar with different security features and concepts that involve a TrustZone® for ARMv8-M devices.

The TrustZone technology is a System-on-Chip (SoC) and MCU system-wide approach to security that enables Secure and Non-Secure code to run on a MCU. It enables creating multiple software security domains that restrict access to selected memory, peripherals, and I/O to trusted software without compromising the system performances. The user can consider the following deployment approaches:

- Single-developer approach (Customer A)
- Dual-developer approach (Customer A+ Customer B)

The Single developer approach involves a unique developer (Customer A), which is in charge of the following:

- Developing, deploying, and protecting the Secure code
- Developing and deploying the Non-Secure code

In the Dual-Developer approach, the first developer (Customer A) is in charge of developing the Secure application and its associated Non-Secure callable library. The Secure Application must be loaded in the SAM L11 NVM and protected.

A different developer (Customer B) will then start Non-Secured application development on a preprogrammed SAM L11 with limited access to Secure resources (call to Non-Secure API only).
This document describes how to debug a solution composed of the following two projects:

- Secure Project
- Non-Secure Project

**Note:** Refer to the "SAM L11 Security Reference Guide" application note, which describes the security features available in the Microchip SAM L11 microcontroller that fulfill the security requirement of most embedded systems.
5.2 Instructional Guide
Follow these steps to explore the Atmel Xplained Pro platform:

1. Download Atmel Studio.
2. Install Atmel Studio.
3. Launch Atmel Studio.
4. Connect the DEBUG USB port on the kit to the PC using a micro-USB cable (Standard-A to Micro-AB). When the Xplained Pro MCU kit is connected to the computer for the first time, the operating system will install the software driver. The driver file supports 32-bit and 64-bit versions of Microsoft® Windows® XP, Windows Vista®, Windows 7, Windows 8 and Windows10.

![Device driver software installed successfully.](image)

When the Xplained Pro MCU board is powered, the power LED (green) will glow. Atmel Studio will auto-detect the specific Xplained Pro MCU and extension boards that are connected. Atmel Studio will present relevant information, such as data sheets and kit documentation.

The ATSAML11E16A device is programmed and debugged by the on-board embedded debugger, hence no external programmer or debugger tool is required.

**Figure 5-2. Atmel Studio SAM L11 Xplained Pro Introduction**
5. Launch Atmel Start from Atmel Studio to Open the Secure Application Project: File > New > Atmel Start Example Project and then open Atmel Start into Atmel studio 7.

Figure 5-3. Open a New Atmel Start Example Project in Atmel Studio

6. Select the “TrustZone Getting Started Example” for the Secure Project (TZ-GetStart-S) from the examples list, and then click OPEN SELECTED EXAMPLE.

Figure 5-4. TrustZone Getting started SAM L11 Secure Project Example Selection

Note: After few seconds the example list will be displayed.
7. Generate the project from Atmel Start to open it in Atmel Studio. Once the project is open, click **GENERATE PROJECT**.

   **Figure 5-5. Atmel Start Secure Project Overview and Generation**

8. The following "New Atmel Start Project" window will be displayed.

   **Figure 5-6. Secure Project Importation View**
9. Modify the following project information:
   – Enter a new Project Name.
   – Click **Browse** to choose a location.
   – For Solution: Create New Solution.
   – For Solution Name, enter *TrustZoneGettingStarted*.
   – Click **OK** to open the project in Atmel Studio.

**Figure 5-7. Modifying the Project Information**
10. To see the project in the Atmel Studio Solution Explorer: View > Solution Explorer or <CTRL> + <ALT> + L.

Figure 5-8. Atmel Studio Solution Explorer Showing Secure Project

Currently, the TrustZoneGettingStarted solution is only composed of the SecureProject.
11. To compile the "TrustZoneGettingStarted" Secure application, build the project: Build > Build Solution or <F7>.

The current building of the project is important as it enables the generation of the Secure library gateway used in the future Non-Secure application.

Figure 5-9. Secure Project Building Output Window
The Secure Application is built, and the Secure library gateway has been generated in the SecureProject/Debug folder:

**Figure 5-10. Compilation Resulting Secure Library File**

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Config</td>
<td>5/25/2018 10:32 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>Device_Startup</td>
<td>5/25/2018 10:56 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>examples</td>
<td>5/25/2018 10:56 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>hsl</td>
<td>5/25/2018 10:32 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>hpl</td>
<td>5/25/2018 10:32 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>hsn</td>
<td>5/25/2018 10:32 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>trustzone</td>
<td>5/25/2018 10:56 AM</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>atmel_start.d</td>
<td>5/25/2018 10:56 AM</td>
<td>D File</td>
<td>19 KB</td>
</tr>
<tr>
<td>atmel_start.o</td>
<td>5/25/2018 10:56 AM</td>
<td>O File</td>
<td>728 KB</td>
</tr>
<tr>
<td>driver_init.d</td>
<td>5/25/2018 10:56 AM</td>
<td>D File</td>
<td>18 KB</td>
</tr>
<tr>
<td>driver_init.o</td>
<td>5/25/2018 10:56 AM</td>
<td>O File</td>
<td>712 KB</td>
</tr>
<tr>
<td>libsecure_gateway_vencer.lib</td>
<td>5/25/2018 10:56 AM</td>
<td>Album Library</td>
<td>1 KB</td>
</tr>
</tbody>
</table>
12. Close the Atmel Start window from Atmel Studio.
13. Reopen a new Atmel Start Example Project to create the Non-Secure application:
   – File > New > Atmel Start Example Project.
   – Open Atmel START directly into Atmel Studio 7.

**Figure 5-11. Open a New Atmel Start Example Project in Atmel Studio**

14. Choose the "TrustZone Getting Started Example" for the Non-Secure Project (TZ-GetStart-NS) from the existing examples list, and then click OPEN SELECTED EXAMPLE.

**Figure 5-12. TrustZone Getting started SAM L11 Non-Secure Project Example Selection**
15. Generate the project from Atmel Start to open it in Atmel Studio, and once it is loaded, click GENERATE PROJECT.

Figure 5-13. Atmel Start Non-Secure Project Overview and Generation
16. The following "New Atmel Start Project" window will be displayed.

Figure 5-14. Non-Secure Project Importation Window
17. Modify the project information as given below:

**Figure 5-15. New Atmel Start Project**

- **Project Name:** rename the project name to “NonSecure Project”.
- **Location:** keep the same location as the Secure Application Project.
- **Solution:** Add To Solution.
- **Solution Name:** Keep the same Solution name used for the Secure Project: `TrustZoneGettingStarted`.
- **Ensure that you Do not click the OK button now.**

**Important:** Make sure to select the adding option by clicking **Add As Link**.

Users need to complete these steps for the Non-Secure Project importation:

- Add the Secure Project Veneer Header file required to add the veneer functions used to communicate between the Secure application and the Non-Secure application. The Secure Project Veneer Header file is located in the `SecureProjectFolder/trustzone` folder. In this example this file is called `trustzone_veneer.h`.
- Add the Secure Project Export Library file required to add the compiled library containing the secure functions used to communicate between the Secure application and the Non-Secure application. The Secure Project Export Library file is located in the `SecureProjectFolder/debug` folder. In this example, this file is called `libsecure_gateway_veneer.lib`.
- Add the Non-Secure Project Linker Script file required to manage the memory allocation (Non-Secure and Secure parts) for the Application Programming. The Non-Secure Project Linker Script file is located in the `SecureProjectFolder/Device_Startup` folder. In this example this file is called `saml11_nonsecure.ld`. 
– Click OK to open the project in Atmel Studio.
18. To see this project using the Atmel Studio Solution Explorer, select View/Solution Explorer or press <CTRL+ALT+L>.

The Solution TrustZoneGettingStarted is now composed of these two projects. These two projects are shown in the following figure.

- SecureProject
- NonSecureProject

Figure 5-17. Atmel Studio Solution Explorer Showing both Secure and Non-Secure Project
19. Configure the Non-Secure project debugger/programmer interface. Open the project properties and then perform this action: Project > Properties or press <ALT+F7>.

20. Click **Tool**.
   - For the Selected debugger/programmer chose “EDBG ATMLxxx”.
   - For the Interface choose “SWD”.

**Figure 5-18. Programming Tool Selection for the Non-Secure Project**

21. Compile the NonSecureProject: To build the project: Build > Build Solution or press <F7>. Check and verify that no errors are reported.

**Figure 5-19. Non-Secure Project Building Output Window**
22. Configure the SecureProject and NonSecureProject for cross-debugging.
   - From the Solution Explorer Window, right-click on the SecureProject file and choose properties.

Figure 5-20. How to access Project Properties in Atmel Studio
– From the SecureProject Properties Window, click Advanced.

**Figure 5-21. Advanced Project Properties Tab**

– Click Add to add the `NonSecureProject.elf` file to the SecureProject additional modules. The `NonSecureProject.elf` is a compiled file located in the `NonSecureProjectFolder/Debug` folder.

**Figure 5-22. .elf File Selection**
The *NonSecureProject.elf* file now accesses part of the *SecureProject* additional modules as shown:

**Figure 5-23. NonSecureProject Properties Window**

- To complete this step, save current properties: *File > SaveSecureProject*.
- From the Solution Explorer window, right-click on the *NonSecureProject* file and choose *Properties*.
- From the *NonSecureProject Properties*, click *Advanced*.
- Click *Add* to add the *SecureProject.elf* file to the *NonSecureProject* additional modules.

**Note:** The *SecureProject.elf* file is a compiled file located in the *SecureProjectFolder/debug* folder. The *SecureProject.elf* file becomes an accesses part of the *SecureProject* additional modules as described:

**Figure 5-24. NonSecureProject Properties Window**

- To complete this step, save current properties by doing this action: *File > SaveSecureProject*. 
23. To set Breakpoints to debug the complete TrustZone Solution, follow these steps:
   – Set a break point in the NonSecure Project.
   – Deploy the NonSecureProject file in the Solution Explorer Window, and open the main.c file.
   – Double-click on the related line to add the breakpoint.

Figure 5-25. Atmel Studio IDE Overview: Break Point Location

In this case, the breakpoint is placed at the line that calls the Non-Secure callable function1, nsc_func_plus3. This function is declared into the libsecure_gateway_veneer.lib file, which is generated once the SecureProject is built.

The call to the secure function, func_plus3, is done in the veneer (Secure Gateway), and the declaration is done in the main.c file of the SecureProject.
   – Set a breakpoint into the Secure gateway trustzone_veneer.c file, at the return func_plus3(x); line.
Figure 5-26. Atmel Studio IDE Overview: Break Point Hit in the Secure Gateway Veneer
Set a breakpoint into the SecureProject main.c file at the `func_plus3` declaration.

Figure 5-27. Atmel Studio IDE Overview: Breakpoint Hit in the Secure Project
Debug your project and see the breakpoint hit in the Non-Secure project, then in the Secure project follow these steps:

- Click 
  or press <F5> to start and execute a new debug session. The execution halts at the first breakpoint located in the NonSecureProject.

  Figure 5-28. Debug Session Window

- Click 
  again or press <F5> to continue the debug session. The execution halts at the second breakpoint located in the Secure gateway (trustzone_veneer.c).

- Click 
  again or press <F5> to continue the debug session. The execution halts at the third breakpoint located in the SecureProject.
Figure 5-29. Debug Session Window

Note: Now both the Secure and Non-Secure projects can be debugged without any restrictions.
The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQ), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products. Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.


Customer Support

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings, BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Heldo, JukeBlox, KeeLoq, KeeLoq logo, Kleer, LANCheck, LINK MD, maXStylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB, OptoLyzer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA, SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight Load, IntellIMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
Quality Management System Certified by DNV

ISO/TS 16949
Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, KEELQ® code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.
<table>
<thead>
<tr>
<th>AMERICAS</th>
<th>ASIA/PACIFIC</th>
<th>ASIA/PACIFIC</th>
<th>EUROPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate Office</td>
<td>Australia - Sydney</td>
<td>China - Beijing</td>
<td>Austria - Wels</td>
</tr>
<tr>
<td>2355 West Chandler Blvd.</td>
<td>Tel: 61-2-9868-6733</td>
<td>Tel: 86-10-8569-7000</td>
<td>Tel: 43-7242-2244-39</td>
</tr>
<tr>
<td>Chandler, AZ 85224-6199</td>
<td>China - Chengdu</td>
<td>Tel: 86-28-8665-5511</td>
<td>Fax: 43-7242-2244-393</td>
</tr>
<tr>
<td>Tel: 480-792-7200</td>
<td>China - Chongqing</td>
<td>Tel: 86-23-8980-9588</td>
<td>Denmark - Copenhagen</td>
</tr>
<tr>
<td>Fax: 480-792-7277</td>
<td>China - Dongguan</td>
<td>Tel: 86-769-8702-9880</td>
<td>Tel: 45-4450-2828</td>
</tr>
<tr>
<td>Technical Support:</td>
<td>China - Guangzhou</td>
<td>Tel: 86-20-8755-8029</td>
<td>Fax: 45-4485-2829</td>
</tr>
<tr>
<td><a href="http://www.microchip.com/">http://www.microchip.com/</a></td>
<td>China - Hangzhou</td>
<td>Tel: 86-571-8792-8115</td>
<td>Finland - Espoo</td>
</tr>
<tr>
<td>support</td>
<td>China - Hong Kong SAR</td>
<td>Tel: 852-2943-5100</td>
<td>Tel: 358-9-4520-820</td>
</tr>
<tr>
<td>Web Address:</td>
<td>China - Nanjing</td>
<td>Tel: 60-3-7651-7906</td>
<td>France - Paris</td>
</tr>
<tr>
<td><a href="http://www.microchip.com">www.microchip.com</a></td>
<td>China - Qingdao</td>
<td>Malaysia - Penang</td>
<td>Tel: 33-1-69-53-63-20</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-532-8502-7355</td>
<td>Malaysia - Kelangur</td>
<td>Fax: 33-1-69-30-90-79</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-21-3326-8000</td>
<td>Malaysia - Penang</td>
<td>Germany - Garching</td>
</tr>
<tr>
<td></td>
<td>China - Shanghai</td>
<td>Tel: 63-2-634-9065</td>
<td>Tel: 49-8931-9700</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-24-2334-2829</td>
<td>Singapore</td>
<td>Germany - Haan</td>
</tr>
<tr>
<td></td>
<td>China - Shenzhen</td>
<td>Tel: 65-6334-8870</td>
<td>Tel: 49-2129-3766400</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-755-8664-2200</td>
<td>Taiwan - Hsin Chu</td>
<td>Germany - Heilbronn</td>
</tr>
<tr>
<td></td>
<td>China - Suzhou</td>
<td>Tel: 886-3-577-8366</td>
<td>Tel: 49-7131-67-3636</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-186-6233-1526</td>
<td>Taiwan - Kaohsiung</td>
<td>Germany - Karlsruhe</td>
</tr>
<tr>
<td></td>
<td>China - Wuhan</td>
<td>Tel: 886-7-213-7830</td>
<td>Tel: 49-721-625370</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-27-5980-5300</td>
<td>Taiwan - Taipei</td>
<td>Germany - Munich</td>
</tr>
<tr>
<td></td>
<td>China - Xian</td>
<td>Tel: 886-2-2508-8600</td>
<td>Tel: 49-89-627-144-0</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-29-8833-7252</td>
<td>Thailand - Bangkok</td>
<td>Fax: 49-89-627-144-44</td>
</tr>
<tr>
<td></td>
<td>China - Xiamen</td>
<td>Tel: 66-2-694-1351</td>
<td>Germany - Rosenheim</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-592-2388138</td>
<td>Vietnam - Ho Chi Minh</td>
<td>Tel: 49-8031-354-560</td>
</tr>
<tr>
<td></td>
<td>China - Zhuhai</td>
<td>Tel: 84-28-5448-2100</td>
<td>Israel - Ra’anana</td>
</tr>
<tr>
<td></td>
<td>Tel: 86-755-3210040</td>
<td></td>
<td>Tel: 972-9-744-7705</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Italy - Milan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 39-0331-742611</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 39-0331-466781</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Italy - Padova</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 39-049-7625286</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Netherlands - Drunen</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 31-416-690399</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 31-416-690340</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Norway - Trondheim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 47-7289-7561</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Poland - Warsaw</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 48-22-3325737</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Romania - Bucharest</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 40-21-407-87-50</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Spain - Madrid</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 34-91-708-08-90</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 34-91-708-08-91</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sweden - Gotenberg</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 46-31-704-60-40</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sweden - Stockholm</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 46-8-5090-4654</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>UK - Wokingham</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tel: 44-118-921-5800</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fax: 44-118-921-5820</td>
</tr>
</tbody>
</table>